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Navigating a Workbook

Every new Excel workbook contains three worksheets. You can use only one worksheet and leave the other
sheets blank, or you can use more than one worksheet to help organize your information. You can also add
more worksheets if you need more than three. An Excel worksheet consists of a grid of rows and columns.
Similar to a Word table, the intersection of a row and column is called a cell. m Before working on the
sales forecast worksheet, you need to start Excel, familiarize yourself with the workbook window, and save a
blank workbook.

QUICK TIP
You can quickly
move the cell
pointer to cell Al
by pressing

press [Ctrl][G] to
open the Go To dia-

i
i
A To navigate quickly
i to a specific cell,
I

log box, type the
cell address you
want to navigate to
in the Reference text
box, then click OK.

QUICK TIP
To add a new work-
sheet, click the Insert

Shest3 sheet tab.

1. Click the Start button @ on the taskbar, click All Programs, click Microsoft Office, then
click Microsoft Excel 2010
Excel starts and a blank workbook opens, as shown in Figure G-1. Excel contains elements that are in every
Office program, including the Ribbon, the File tab, the Quick Access toolbar, a document window, scroll bars,
a status bar, View buttons, and window sizing buttons.

2. View the worksheet window :
The cell with the dark border in the upper-left corner of the worksheet is called the active cell. The dark
border surrounding the active cell is the cell pointer. You must click a cell to make it active before enter-
ing data. Every cell in a worksheet has a unique cell address, which is a specific location of a cell in a
worksheet where a column and row intersect. A cell address consists of a column letter followed by a row
number (such as B33). When you first start Excel, the active cell in the new workbook (Book1) is cell Al,

wlfere column A and row 1 intersect. C /L ﬂ /U
3. Click cell C1

Cell C1 becomes the active cell. Clicking a cell selects it and makes it active. Table G-1 lists several methods
for selecting cells with the mouse or keyboard. Notice that the column and row headings of the active cell
(column C and row 1) appear in a contrasting color. The name box shows the address of the selected cell,
and the formula bar, located just above the column headings, shows the contents of the selected cell (it is

currently empty). The mouse pointer changes to o when you move it over any cells in the workbook.

4. Press [+], press [¥], then press [Tab] )
Cell E2 is now the active cell. You can move to and select a cell by clicking it, by using the arrow keys, or by
pressing [Tab] (to move one cell to the right), [Shift] [Tab] (to move one cell to the left), or [Enter] (to move
one cell down).

5. Click the Sheet2 sheet tab
Sheet2 becomes the active sheet, and cell A1 is the active cell. To work with different sheets in a workbook,
you click the sheet tab of the sheet you want to see.

6. Drag the 0 pointer from cell A1 to cell C5
Cells A1 through C5 are selected, a total of fifteen cells, as shown in Figure G-2. A group of cells that share
boundaries and are selected is called a cell range. To reference a cell range, use the cell address of the first
cell in the range followed by a colon and the cell address of the last cell in the range. The cell range you
selected is A1:CS.

7. Select the cell range D8:D14
Cells D8 through D14 (a total of seven cells) are selected.

8. Click the Sheet1 sheet tab, then press [Ctrl][Home]
Clicking the sheet tab returns you to Sheet1, and the keyboard shortcut returns the cell pointer to cell Al.

9. Click the Save button &l on the Quick AccessAothar, navigate to where you store your
Data Files, then save the file as G-Kite Sale -ﬂ@
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Entering Labels and Values

Entering data in a worksheet is similar to typing in a Word table. First, click the cell in which you want to

—lenter data, then type the data you want to enter. After typing the data, you must accept the entry by press-
c (/L/ @ng [Enter], !ab], or an arrow key. Most worksheets contain labels and values, ’ is text that describes

UNIT

Excel 2010

=" datain a worksheet, Values are numeric data that can be used in calculations. You can edit a cell entry by

J Y a/ (e double-clicking the cell to put the cell in Edit mode. In Edit mode, select the part of the cell entry you do not

/ AL want, then type your corrections. &S89 This worksheet needs to provide the names of the kite products,
v

net prices, estimated first year units, and estimated first year sales for each kite. To begin your work on the
15 lg_s forecast worksheet, you decide to enter the labels and values. '
¥4

1. In cellﬂdypm

As you type, the text appears in cell Al and in the formula bar, as shown in Figure G-3. The text you typed is
a label that describes the first column of data in the worksheet.

2. Press [Tab] :
Pressing [Tab] accepts your entry and activates the next cell in the row, cell B1. The name box shows B1 as the
active cell. You need to type two more labels.

3. Type Net Price, press [Tab], then type Year 1 Units
Year 1 Units is too long to fit in cell C1; althomnto cell D1, it is actually contained only in cell
- CL.1If cell D1 contained any data, then only the part of the label that fits in C1 would appear.

4, Press [Enter]

Cell A2 is now the active cell. You need to type a kite product name in this cell.
3. Type Apache Delta, then press [v]

Cell A3 is now the active cel. Pressing [¥] accepted the cell entry and moved the cell pointer to the cell below,
6. Type Volcano Blaster, press [Enter], type Tornado Twirler, press [Enter], type Whirling Delta,

press Wm press [Enter], type Soaring Fagle, then press [Enter]

You have typed all the product names. Cell A8 is the active cell. You need to make an edit to one of the names.

7. Double-cli 4
bouble-ch‘cking the cell put cell A4 m@ Notice that the insertion point is flashing in cell A4, You
can now select part of the cell entry to edit it, just like in Word.

8. Double~click_1:£i§|_g& pe Trickster, then press [Enter] a
Cell A4 now contains the label Tornado Trickster. ﬂ/ﬁf;é /

9. Click cell B2, type 15.75, then press the Enter button {%] on the formula bar _
Unlike pressing [Enter] on the keyboard, clicking the Enter button keeps the cell active. Notice that SO@

QUICK TIP

Pressing [Tab] has
the same effect as
pressing [#-].

QUICKTIP
Pressing [Ctrl](Enter]
has the same effect

as clicking the Enter
button,

Apache Delta is cut off in cell A2 because cell B2 now contains data. /VU /~

10. Press [+], type 7500, then press [
You entered the value for Year 1 Units for the Apache Delta kite in cell C2.

11. Enter the values shown in Figure G-4 for the range B3:C7, then save your changes

- 1705
e -2

Creating a Worksheet

of
- 4
cﬁ‘nm

N2 I R e

i)

Peeeee

]

1

® ®

14

¢




- 2 g i3

FIGURE G-3: Worksheet text in active cell and formula har
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FIGURE G-4: Worksheet after entéring labels and values

Labels Label in C1

spills into
cell D1
because D1
is empty

\ Enter this

s data as
I . shown

i i
f f

Column A labels are cut off
on right side because

£ adjacent cells contain data
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Working with Columns
and Rows

You can adjust the width of a column or the height of a row using the mouse, Ribbon, or shortcut menu. Using
the mouse is a quick and easy method when you do not need an exact width or height. You can also jnsert or
delete columns and rows using the Insert and Delete buttons in the Cells group on the Home tab. S You
need to insert two rows above the labels and enter a worksheet title in the new top row. You also need to

m adjust the column widths so that the labels will be visible.

| the new one, then

To AutoFit more
than one column at
a time, drag to
select all the column
headings of the
columns you want
to widen, then
double-click any
column boundary in
the selection.

To insert a column,
click the column

heading to the right.
of where you want

click Insert in the
Cells graup.

1. Position the mouse pointer on the column bounda between column heading A and

column heading B so that the pointer changes t s shown in Figure G-5
The boxes containing the letters A and B are column headings, and the boxes containing numbers in front
of each row are row headings.

2. Double-click 4 between column headings A and B
Double-clicking a column boundary automatically widens or narrows it to fit the longest entry in the column
using a feature called AutoFit. The kite names in cells A2:A7 are now fully visible.

3. Point to the column boundary between columns C and D, then drag +b to the right of
the s in “Units” in row T T

Column C is now wider, so that the entire Jabel Year 1 Units now fits in cell C1. When you drag a boundary,
a dotted line appears to help you position it right where you want it.

4. Click the row 1 row heading
Row 1 is now selected. Clicking a row heading selects the entire row, You want to insert two rows above row 1.
3. Click the Insert button in the Cells group twice
e i

Two new rows are inserted above the labels row, The cell addresses for the cells containing the lab ang‘val-
ues you entered have all changed to reflect their new locations. ef

Y
6. Click cell A1, type Year 1 Kite Product Sales F then press [Enter] ¢ U\ f {M“‘l Aj
J [

The worksheet title now appears in cell A1

7. Point to the boundary between the tow 2.and-3-row headings, then drag ¥ down until
the ScreenTip reads Height: 24.00 (32 pixels), as shown in Figure G-6
The height of row 2 changes from 12 to 24 points (32 pixels). The extra space creates a visual separation
between the worksheet title and the labels, You can also use the Format button in the Cells group to adjust
column width or row height if you know the precise measurement you want.

8. Click cell A2, click the Format button in the Cells group on the Home tab, then click

Row Height .

The Row Height dialog box opens, as shown in Figure G-7. The Row height text box displays the selected
value 24, the height you specified in Step 7.

9. Type 30, click OK, then save your changes
The height of row 2 increases to 30 points (40 pixels) to reflect the change you made.

; MrﬁLJ
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Using Formulas K

To perform a calculation in a worksheet, you enter a formula in a cell. A formula is an equation that per-
forms a calculation. Formulas start with an equal signd can contain numbers, mathematical opera-
tors, and cell references, A ceﬁfg}eme is a cell address, such as E44, that identifies the location of a
value used in a calculation. Table G-1 lists some mathematical operators and sample formulas. If more
than one operator is used in a formula, Excel performs the calculations in the order listed in Table G-2,
which s a standard order used in math called the order of precedence. You can copy and move formu-
las just like other data in a worksheet. When you co ew cell, Excel automatically replaces
the original cell references with cell references that are in the same relative position as those in the original
formula. This is called relative cell referencing. S5 In the kite sales forecast worksheet, you need
to create a formula that calculates the year 1 forecast for each product, which is the net price multiplied
by the year 1 units. You first create a formula that calculates the year 1 sales for the first product, then
copy the formula to other cells.

QUICK TIP
You can also enter
cell references in a
formula by typing
them, using either
uppercase or lower-
case lefters.

You can alsosdguble—~

| click the fill handl
to Auto Fi rmula
to the adjacent cells

below. The formula
will be copied down
to the last cell that is
next to a cell con-

taining data.

If you want your
worksheet to display
formulas instead of
their results in cells,
click the Formulas
tab, then click Show
Formulas in the

Formula Auditing
group.

m Creatinga Worksheet [Lﬂ

1. Click cell D3, type Year 1 Sales, then press [Enter]

Year 1 Sales is now a label in cell D3, and the active cell is now D4.

b

Typel=

The equal sign (=) indicates that you are about to enter a formula in cell D4. Everything you enter in a cell
after the equal sign, including any numbers, mathematical operators, cell references, or functions, is included
in the formula,

o

Click cell B4 _
A dotted bgrﬁgappears around cell B4, and B4 now appears in both the formula bar and cell D4.

4, Typ@an asterisk), then click cell C4
See Figure G-8. In Excel, the asterisk symm the operator for multiplication. When Excel calculates the for-
mula, it will multiply the value in cell B4 by the value in cell C4. Using cell references ensures that the formula
will automatically update if the values in B4 and C4 change. )

; ] '
Click the Enter button & on the formula bar 6"{6
The result of the formula (TT812 appears in cell D4. Notice that although the formula’s result appears in cell D4,
the formula =B4*C4 appears in the formula bar. To save time, you can copy the formula in D4 to cells D5:D9.

Point to the_small black square in the Jower-right corner of cell D5, then when the pointer
changes to =+, drag <+ down to cellfé§-

Excel copies the amount formula in cell D4 into cells D5 through D9. Notice that cells DS:D9 display the
results of the copied formulas, as shown in Figure G-9. The small black square that you dragged is called the
fill hg% The icon that appears after you release the mouse button is the Auto Fill Options button, which
you can click to choose additional options when copying cells,

s

&

7. Click cell D6, then save your changes
The formula bar shows the formula =B6*C6. Notice that the copied formula uses different cell references than
those used in the original formula. When Excel copied the formula to cell D6, it adjusted the original cell
references relative to the new formula location.
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Using AutoSum

Excel comes with a wide variety of functions, which are prewritten formulas designed for particular types

of calculations. The most frequent worksheet function, SUM, totals all numbers and cell references
included as function arguments. An argument is information a function needs to make a calculation, and

can consist of values (such as 100 or .02), cell references (such as B3), or range references (such as A9:G16).
Functions save time and help ensure accuracy, and they are available for both simple calculations and
extremely complex ones. Each Excel function has a name that you usually see in all capital letters, such as
AVERAGE or DATE. Because the SUM function is so commonly used, it has its own button on the Home tab
also known as, the AutoSum button. m You are now ready to add up the Year 1 Units and Year 1 Sales
columns. You decide to use the AutoSum button.

B STEPS |

You can view the

sum and average of
a selected range on
the status bar, as
well as the number
of cells in the range
(indicated by the

Count: value).
| —

c

oo
o

Excel 154

1. Click cell C10__
Cell C10 is now the active cell. You want C10 to display the total year 1 units for all of the kite products,
which is the sum of the range C44

2. Click the AutoSum buttorf{X/n the Editing group on the Home tab
A flashing dotted border appeatg #found the cells in the range C4:C9, as shown in Figure G-10, indicating that
these are the cells that Excel assumes you want to add together. The function =SUM(C4:C9) appears in
cell C10 and in the formula bar, ready for you to edit or accept. When you use a function, Excel suggests a cell
or range to add. With AutoSum, it is usually the group of cells directly above or to the left of the cell contain-
ing the function.

3. Click the Enter button [¥] on the formula bar
Excel accepts the formula and the result, 49500, appears in cell C10.

4. Click cell D19, click the AutoSum button, then click &
When you clicked the AutoSum button, Excel guessed (correctly) that you wanted to calculate the sum of
cells D4:D9, the cells directly above cell D10. See Figure G-11.

5. Click cell B4, type 22.25, then click [¥]

Changing cell B4 automaticaH% changed the formula results in cell D4 (for the Apache Delta Year 1 Sales) and )

also for the total sales in ce 0, as shown in Figure G-12, because these formulas use the value in cell B4.
You can see what a valuable tool Excel is; changing one value in a cell changes the results in any cell that
contains a cell reference to that cell.

6. Save your changes

Creating a Worksheet
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Changing Alignment and
Number Format

When you enter data in a cell, Excel automatically left-aligns text and right-aligns values. You can change
the alignment to left-, right-, or center-align cell contents using the buttons in the Alignment group on the
Home tab. You can also use the Merge and Center button to merge several cells into one cell and center the
text in the merged cell. Using the Merge and Center button is helpful for formatting a worksheet title so that
it is centered above the worksheet data. You can also change the format of numbers to make your work-
sheet easier to read using the buttons in the Numbers group. For instance, you can quickly format a value
Orrange as currency or as a date, or format numbers so that they contain commas, decimals, or both. You
can also insert rows and columns in your worksheet; when you do so, any cell references are updated to
reflect the change. 2B You decide to apply number formats and adjust alignments to improve the work-
sheet's appearance. You also need to add a new column that includes the release date for each kite, format

m the column labels in bold, and merge and center the worksheet title.

1. Select the range C4:C10, then click the Comma Style butto M the Number group
The numbers in column C are now formatted with a comma and include two decimal places. The decimal
places are not necessary for the unit estimates, since all the values are whole numbers.

2. Click the Decrease Decimal buttor[#]in the Number group twice
The numbers in column C now appear withett decimals.

3. Select the range B4:B9, press and hold }Ctrf], select the range D4:D10, then click the

% Number Format buttor($ [jithe Number group
) Pressing atrd holding [Ctrl] when you select cells lets you select nonadjacent cell ranges. The Net Price values

in column B and Year 1 Sales values in column D are now formatted as currency, as shown in Figure G-13.

)

Excel 2010

To increase the
number of digits fol-
lowing a decimal
point, click the

Increase Decimal
button in the

b |

.@iﬁ%%@&%@;@@@@@@@Q-ﬂ?iﬁé‘i!

Number grpup. |
M (J % 4. Click the column C heading, then click the Insert button in the Cells group *
Jg / il A new column is inserted to the left of the Year 1 Units column. You need to enter a label in cell C3, !
. . - . M
7/ J 3. Click cell C3, typeﬂeleﬁse\!)_qte, click the Enter button ¥ on the formula bar, then click & f
the Wrap Text button [5in the Alignment group @)
; i R4 j’ ) Clicking the Wrap Text button wrapped the Release Date text to two lines, Now the entire label is visible in cell C3. !
( 6. Click cell C4, type March 1, 2013, then click &
Excel recognized that you typed a date in cell C4 and changed the format to 1-Mar-13. You can use the
Number Format list in the Number group to change the date format.

7. Click the Number Format list arrow, as shown in Figure G-14, then click Short Date
The format of the date in cell C4 is now 3/1/2013. You can copy this date to the other cells in column C using
the Copy and Paste commands.

8. Click the Copy button [%]in the Clipboard group, select the range C5:C9, click the Paste
button [&]in the Clipboard group, then press [Esc] {/ij e
Now all cells in the range C5:C9 display the date 3/1/2013. i/ {

9. Click the row 3 heading, click the Center button [=in the Alignment group, then click

the Bold button|B] in the Font group

—Each label in row 3 is now center-aligned and bold, and stands out from the data in the worksheet.

10. Select the range A1:E1, click the Merge and Center button in the Alignment group, then
save your changes T ‘

cell contents at any As shown in Figure G-15, the worksheet title is centered across the five selected cells, which have merged into

ke pouspediy one cell. Note that the cell address for this cell is still Al '

m Creating'a Worksheet

The Alignment
group also has but-
tons to align text at
the top, middle, or
bottom of a cell,

The Orientation but-
ton in the Alignment
group lets you align




I{NIT

Excel 2010
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and values, m You decide to add a header that contains your name, and a footer that contains the date

m and file name. You also decide to apply a theme and add borders and shading.
1. Click the Layout B on the status bar, then click the Click to add header
. placeholder in the header area A

The worksheet is now in Page Layout view, and the insertion point is above the worksheet title in the middje
of the header’s three sections,

2. Click the right section of the header area, then type your name

Your name appears in the right section of the header, right-aligned, as shown in Figure G-16. The Header &
Footer Tools Design tab is now available on the Ribbon.

QUICK TIP
If your worksheet
contains multiple
pages, you can click
the Page Number
button to insert a
page number.

fader&-kooter Tools Design tab if necessary, then click the Go to Footer
, . . '_“*-_-_"—‘—-.
button (&] in the Navigation group

4. Click thﬂngg footer area, then click the Current Date button in the Header y
& Footer Elements group T T

Excel inserts the code “& [Date]” into the left section of the footer area, When you click outside of this sec-

tion, the actual date will appearhere, il

QUICKTIP 5. Click the right section of the footer area, click the Fj utton in the Header & o
YDUhCﬂl:j fnse";a pre- Footer Elements group, then click any cell in the worksheet
ffﬁicﬁamerftj{n;’: M N The filename appears in the right side, and the date is in the left side of the footer area, as shown in Figure G-17. 8l

selected combina-
tion of text and

6. Click the Normal view button B on the status bar, then press [Ctrl][Home

‘ Y
codes, by clicking Cell A1 is now active, and the worksheet appears in Normal view, The vertical dotted line to the right of col- b
the Headebr button umn H indicates the page break line, This line is helpful to see if your worksheet contains many columns and &
or Footer button in : .
the Mesde S Ficts you need to fit all columns panone page. . =
group, then clicking . Click the Page Layou click the Themes button in the Themes group, then click the . o
a selection; Fxcel 7 Y TR pan, et — g P l

:..Concourse theme

[he Concourse theme is applied to the worksheet.

replaces any existing
text with the preset,

A ) 8. Click the Home ta{), select the range AT:E10, click the Borders list arrow | “in the Font
r ﬁg A‘i (’% group, then click All Borders " C =
‘ 3{ A Cells AT:E10 now have borders applied to them.

n \g 9. Select the range A3:E3, click the Fill Color [ist arrow [#Jin the Font group, click Light

Turquoise, Background 2 (third square in top row), click cell AT, then save your changes
The column labels are now shaded in light blue. Compare yo

ur screen to Figure G-18,

m Creating a Worksheet
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When you finish working with a worksheet and have saved your work, you are ready to print it. just like .

in Word, you can use the Print tab in Backstage view to preview the printed worksheet and specify set- ¥

tings. You can change the orientation, adjust margins, specify the printer, specify the paper size, and 2

more. S You have finished working with the worksheet, and are ready to preview and print it. )

gr“

m (Note: Many schools limit printing in order to conserve paper. If your school restricts printing, skip Step 6.)

QUICK TIP 1. Click the File tab, then click Print =
To open the Print ta The Print tab opens in Backstage view, and the sales forecast worksheet appears in the Print Preview area, as

o Biacktage v shown in Figure G-19. Notice that the header and footer text appear at the top and bottom of the page. The 24
worksheet is set to print in portrait orientation (where the page is taller than it is wide); you can change this o
to landscape orientation (where the page is wider than it is tall). W
2. Click &thfait_f_)jigﬂatigg in the Settings area, then click Landscape Orientation e
The Print Preview area shows the worksheet in landscape orientation, as shown in Figure G-20. &
3. Click the Show Margins button [& in the lower-right corner of the Print Preview area =
To change the mar- Lines appear on the worksheet indicating the location of the margins at the Normal setting. The margins look L5
gin settings, click fine at the Normal setting, so there is no need to change this setting. &
Normal Margins i " =1 . A ; <
thzrgneartfngirglr:;,m 4. Click the Zoom to Page button [& in the lower-right corner of the Print Preview area
then click a different The worksheet appears up close in the Print Preview area, giving you a magnified view of the worksheet data, o
1 as shown in Figure G-21. &
5. Verify that your printer is on and connected to your computer, and that the correct N
As an altemative to printer appears in the Name text box L
Print Preview, you 7 . . .
can verify the page 6. If your school allows printing, click the Print button, otherwise skip to Step 7 B
E;::?Sb;] gﬁﬁn‘gﬂm The document prints, and the Home tab opens, s
gzg;gfsz“tﬁf:t':tﬁs 7... Save your changes, click the File tab, then click Exit o
bar. You can adjust The worksheet is saved, and the worksheet and Excel both close. g
where page breaks : i . }
arelocated by drag- | &+ Submiit your completed worksheet to your instructor e
ging them with your
mouse, e
==
o)

m Creating a Worksheet
:



Select the best answer from the list of choices.

18.

19.

20.

21.

22,
- a. Copying a formula from cell A5 to cell F10

The name of the cell located in column F and row 223 is:

a. 223F ¢. F222
b. F223 d. 22F3
Which of the following formulas is NOT correctly written?
a. B7+AS= ¢, =7+B55
b. =AS*B7 d. =B22*7

Cell E7 contains the formula =C7+D7. If you copy the formula in E7 to cell E8, which of the following
formulas will E8 contain?

a. =Co+D6 c. =C8+D8

b. =D7+D8 d. =C7+C8

Which of the following actions does NOT accept a formula after you type it?
a. Pressing [Tab] c. Clicking v]

b. Pressing [Enter] d. Pressing [Ctrl][P]

For which of the following tasks would you NOT use the fill handle?

b. Copying a formula from cell A2 to the range A3:A7
c. Copying a label from cell A2 to A3
d. Copying a formula from cell F22 to the range F23:F25

Skills Review

1.

Navigate a workbook.

a. Start Microsoft Excel,

b. Identify the program window elements without referring to the lesson material

Click cell H22, then click cell B25.

d. Switch to Sheet2, select the range H2:K22.

e. Switch to Sheetl, then use the keyboard to place the cell pointer in cell Al.

f. Save the workbook as G-Weekly Sales in the drive and folder where you store your Data Files.

0

. Enter values and labels.

a. Starting in cell Al, type the following labels in the range A1:D1:
Bread Type Quantity Sold  Unit Price  Total Sales

b. Enter the following labels for Bread Type in the range A2 through A8: White, Whole Wheat, Rye,
Pumpernickel, Bagels, Muffins, Specialty Breads.

¢. Use the table below as a guide to enter the values for Quantity Sold (in the range B2:B8) and the values for Unit Price
(in the range C2:C8):
Quantity Sold Unit Price

1217 2.25
1457 2.95
122 2.95
87 2.95
1356 75

1785 95

102 5.95

. Work with Columns and Rows.

a. Increase the size of column A by dragging the appropriate column boundary so that the column is wide enough to fit
all the labels in thé tange A1:A8.

b. Increase the width of column B by double-clicking the appropriate column boundary.

¢. Insert two rows above row 1.
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Skills Review (continued)

d. Enter the label Uncle Bob’s Bread Shop Weekly Sales in cell Al. Apply bold formatting to cell Al.
e. Increase the height of row 2 to 33 pixels using the dragging method. Open the Row Height dialog box to verify that the
row height is 33,
f. Save your changes.
4. Use formulas.
a. Type a formula in cell D4 that multiplies the value of cell B4 and the value of cell C4, then use a button on the formula
bar to accept the entry. When you create the formula, add the cell references to the formula by clicking the cells.
b. Type a formula in cell D5 that multiplies the value of cell BS and the value of cell CS, then use a keyboard command to
accept the entry.
c. Use the fill handle to copy the formula you entered in cell D5 to the range D6:D10.
— d. Save your changes.
5. Use AutoSum.
a. Use the AutoSum button to enter a formula in B11 that adds the values in the cell range B4:B10,
b. Use the AutoSum button to enter a formula in C11 that adds the values in the cell range C4:C10.
c. Use the AutoSum button to enter a formula in D11 that adds the values in the cell range D4:D10.
d. Change the Quantity Sold value for Pumpernickel to 99, then view the changes in cells D7 and D11.
e. Save your changes.
6. Change alignment and number format.
a. Apply the Comma Style number format to the cell range B4:B11. Use a button to remove the decimals for the
selected range.
b. Apply the Accounting number format to the cell range C4:D11.
c. Insert a column to the left of column D. Enter the label Close Date in cell D3. Format this cell so that the label
i wraps to two lines in the cell.
i d. Enter the date May 4, 2013 in cell D4. Use the Number Format list to apply the Short Date format to this cell. Use
‘ the fill handle to copy cell D4 to the range D5:D10. Widen column D, if necessary, so that all the dates are visible.
; e. Center the labels in the cell range A3:E3. Apply bold formatting to cells A3:E3.
f. Merge and center cells A1:F1.
& Save your changes.
7. Enhance a worksheet.
' a. Change to Page Layout view.
i b. Type your name in the right section of the header.
: ¢. Switch to the footer, then insert the current date in the left section of the footer. Insert a code for the filename in the
i right section of the footer.
- Move the cell pointer to cell A1, then change the view to Normal view.
Apply the Angles theme to the worksheet.
Apply the fill color Orange, Accent 2, Lighter 80% to the labels in row 3 (range A3:E3).
. Apply the All Border border style to the range A1:E11.
. Save your changes.
8. Preview and print a worksheet.
. Preview the worksheet using the Print tab in Backstage view.
b. Change the orientation to Landscape.
¢. Change the orientation back to Portrait.
d. Use a button to view the margin rules on the worksheet.
. Use a button to zoom in on the worksheet.

® aa oo oa
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Skills Review (continued) FIGURE 6-23 /

f. If your school permits printing, verify that the Yaur Name —‘
printer settings are correct, then print the work- Uncla Bob's Bread Shop Wealkiy Sales
sheet. Compare your completed worksheet to -
Flgure G-ZB. V\‘hi!.anm”ype qnami:‘:? “"3:":; 5/22?)13 $ :;218.25
8. Save your changes, close the workbook, exit e T 2035 s 2815
Excel, then submit your completed workbook to P T o o s
your instructor. s T e b
$ $

6,138 18.75 11,008.00

Independent Challenge 1

You are a sales representative at Green Farth Stationery,
Inc., a small environmentally friendly paper products
company based in Chicago. Your manager, Anne
Badders, has asked you to provide her with a worksheet
that shows the top five orders in your region for the
month of April. The summary needs to include the
order number, account name, order date, order total, -
and payments received. The worksheet also needs to
show the monthly sales total and the outstanding bal-
ance due.

m
x
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a. Open a new workbook, then save it as G-Top
Five Orders in the drive and folder where
you store your Data Files.

b. Enter the title Top Five Orders for 571072013 G- Woeky Seles e
April, Midwest Region in cell Al.

c. Enter the information shown in the table below, starting in cell A3.

Order Number Account Name Date Total Paid
4596 Card Giant, Inc. April 10, 2013 15946 7865
4597 Office Hub April 17, 2013 7247 0 4
4987 s Stationery, Etc. April 19, 2013 6534 5024 |
5094 Paper Mega Store April 22, 2013 12259 8540
5895 Office Champ April 30, 2013 4095 4095 ;
d. Widen or narrow each column as necessary so that all the labels and data in the range A3:E8 are visible. f
e. Add the label Balance Due in cell F3. Apply bold formatting to the range A3:F3. Widen the column if necessary. |
f. Enter a formula in cell F4 that subtracts cell E4 from cell D4, then use the fill handle to copy the formula to cells F5:F8.
& Use the AutoSum button to enter a formula in cell D9 that adds the values in the range D4:D8. Then change the !
amount in cell D6 to 9544. f
h. Use the fill handle to copy the formula in cell D9 to cells E9 and F9. l
i. Center-align the order numbers in cells A4:A8, then center-align the labels in row 3. |
j. Apply the Accounting number format to cells D4:F9. !
K. Merge and center cells A1:F1. Apply bold formatting to the merged cell. Increase the font size of the title in cell Alto
14 point. (Hint: Select cell A1, click the Font Size list arrow, then click 14.)
L. Change the date format in the range C4:C8 to the Short Date format.
m. Apply bold formatting to the totals in row 9.
n. Add your name in the right section of the header. Add the filename to the right section of the footer. :
0. Apply the Solstice theme to the workbook.
p. Apply All Borders to the range A3:F9, then apply a Thick Box Border around the range A3:F8. / 1 M
q. Apply a fill color to the range A9:F9, choosing the lightest shade of green (Green, Accent 4, Lighter 80%). Apply this J |

same shading to the range A3:F3.
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Independent Challenge 2 (continued)

j» Merge and center cells A1:F1, so that the worksheet title is centered in the merged cell Al. Then merge and center cells
A2:F2, so that the worksheet subtitle is centered in the merged cell A2.

K. Apply bold formatting to the worksheet title, the labels in row 4, the city labels in AS5:A9, and the Totals label and val-
ues in row 10. '

1. Apply a theme of your choosing to the workbook. Enhance the worksheet further by applying fill colors and borders
where appropriate to make the worksheet visually appealing. Increase column widths as necessary so that all labels and
values are visible in each cell.

m. [nsert your name in the left section of the header.

n. Preview the worksheet in Backstage view. Save your changes, close the workbook, and exit Excel. Submit your com-
pleted workbook to your instructor.

Independent Challenge 3

You own a used car business called Joe's Car Shop. You buy preowned vehicles, pay contractors to fix them up, and then resell
them for a profit. You decide to create a spreadsheet to track your profits for cars you have sold in the first quarter.

a. Create a new workbook and save it as G-Q1 Profits in the drive and folder where you store your Data Files. %ﬂ
b. Enter the company name Joe’s Used Autos in cell Al. Enter Q1 Profits in cell A2. o
c. Enter the labels and data shown in the table below, starting in cell A4, Use Accounting number formatting for the cells §

that contain dollar amounts. =)

Vehicle Purchase Price Cost to Fix Sale Price Date Sold

Toyota Corolla 3750 $350 $1,750 January 15, 2013

Nissan Sentra 32,025 $764 $7,995 February 1, 2013

Ford Taurus $2,250 $578 $5,995 February 8, 2013

Homnda Civic $2,015 $1,095 $7,775 March 1, 2013

Mazda Protege $1,725 $775 $7,995 April 1, 2013

d. Adjust the width of the columns as necessary, so that all the data in each cell in the data area is visible.

e. Insert a new column to the left of Sale Price. Enter the label Total Investment in cell D4. Format the label and
adjust the column width so that the label is on one line in the cell.

f. Enter a formula in cell D5 that sums cells BS and CS.

8- Copy the formula in cell DS to cells Dé:D9.

h. Type the label Profit in cell G4. Enter a formula in cell G5 that calculates the total profit for the Toyota Corolla.
(Hint: The formula needs to subtract the value in the Total Investment cell from the Sale Price cell.)

i. Copy the formula in cell G5 to cells G6:G9.

j Add the label Total to cell A10. Enter a formula in cell B10 that sums cells BS:B9. Use the Copy and Paste commands to
copy this formula to cells C10:E10 and to cell G10.

k. Center-align the labels in row 4, then apply bold formatting to these cells. Apply bold formatting to row 10.

1. Change the number format of the Date Sold values to the Short Date format. )

m. Format the worksheet by applying a theme, adding borders, and adding fill colors to enhance its appearance. Format
the worksheet title in cell A1 so that the font size is larger than that in the rest of the worksheet.
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Independent Challenge 3 (continued)

n. Add your name to the center section of the header. Add the filename to the right section of the header. Save your
changes.

o. Preview the worksheet in Backstage view, Change the orientation to Landscape. Save your changes. Figure G-24 shows
the completed worksheet with possible formatting options applied.

FIGURE G-24

Your Name G-Q1 Profits.xlsx

Joe's Used Autos

Q1 Profits s D @

Vehicle Purchase Price| Cost to Fix [Total Investment| Sale Price [ Date Sold Profitn,
Toyota Corolla H 750.00 | § 350.00 | § 1,100.00 | §  1,750.00 1/15/2013| § 650.do
Nissan Sentra $ 2,025.00 | § 764.00 | § 2,780.00 | $ 7,995.00 2/1/2013| 3 s5{206.00
Ford Taurus $ 2,250.00 | § 578.00 | § 2,828.00 [ 5 s5,995.00 2/8/2013| 3 3,167.00
Honda Civic 5 2,015.00 | $ 1,095.00 | $ 13,1000 | $ 7,775-00 3/1/2013| $  4i665.do
Mazda Protégé $ L,725.00 [ $ 77500 | § 3,500/00 | 8 7,995.00 41/203| 5 skos.00
Total $ 8,765.00 | $ 3,562.00 | § 12,327.00 | $ 31/5l0.00 $ 19,\@ oo

=

D o S

Advanced Challenge Exercise
oW ¥ Enter the label Profit as % in cell H4. Use the Format Painter button to copy the formatting of cell G4 to H4.
C Widen column H if necessary so that the entire label fits in cell H4.
E Enter a formula in cell H5 that calculates the percent of the profit made. (Hint: Divide cell G5 by cell D5.)
Copy the formula in cell H4 to cells H5:H10.
Select cells H4:H10, then click the Percent style button in the Number group on the Home tab.

Apply the same border style and fill colors that are applied to cells G5:G10 to the cells in range H5:H10. Save your
changes.

p. Close the workbook, exit Excel, then submit your completed workbook to your instructor.

Real Life Independent Challenge

You just got a new job that pays more than your current position. You have decided to move into a better apartment, without
roommates, and you have found a new apartment that looks perfect. However, you are concerned that the new apartment will

- hurt your ability to save for a house. Not only will the new apartment cost more to rent, but you will need to pay additional

money for other living expenses that will be necessary in this new situation. For instance, you currently walk to work, but the
new job will require you to lease a car and pay for gas and insurance. You will also have to pay more for utilities and cable TV,
since you will not be sharing these expenses anymore. You decide to create a budget spreadsheet that compares your current
living expenses to your expected new expenses in the new apartment, and determine what impact this will have on your
monthly savings.

a. Start Excel, then save a new workbook as G-Budget Comparison in the drive and folder where you store your
Data Files.
b. Enter the title Budget Comparison in cell Al.
c. Enter the following labels in cells A3:A5:
New Monthly Salary
Current Monthly Salary
Salary Increase
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Visual Workshop

Create the worksheet shown in Figure G-25 using the commands, formulas, and formatting skills you learned in this unit. Use
formulas in cells D5:D12 to calculate the June total revenue for each cottage, Use formulas in G5:G12 to calculate the July total
revenue for each cottage. Use the AutoSum button for the totals shown in row 13. Enter a formula in cell B15 that sums the
June and July weeks. Use a formula in cell B17 that sums the total revenue for June and July. Apply the Apothecary theme, and
apply the borders and shading shown. Save the workbook as G-Summer Rental Revenue in the drive and folder

where you store your Data Files, with your name in the center section oft
mit it to your instructor.

he footer. Save and preview the worksheet, then sub-

FIGURE G-25
Castaway Cottage Rentals
Jure ond July Rerdo! Revenue
: hme | | dune | July i
| Weely | JuneWeeks | Tolgh, | Weekly |uly Weeks July Toted ]
Bire's Mozt % S5 2 $11.590|3% 595 4 3 S7E0
Catmmna ¥ s 3 $12358)% 1095 3 $ | 3285
Beir Cave F 845 4 Fiessd|[§  sds S A 3 | s7e0]
SunetHideawzy |5 1075 2 f \2i70[§ 13es 3 3 \478d
Sunshine Gabin $ 1125 1 3 NIES[ % 1a4ws 4 ¥  \ss&
Bosmomlote= |4 725 2 f 1450|% 1085 4 $ 4100
MunchiinCastle |$  &95 3 } 2085|4995 5 3 2985
Captuin’s Neck § o5 e 3 51 1,195 FE =)
Tokols i T Q‘%‘ﬁf) ; fzr; 15 (38055
£ A — / st
[ofolWeeks | a9 1{\'}\_, ]

ToWr Name

[
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